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Chapter 1

Project Management; What s It,
and Why Should | Care?

In This Chapter

Discovering how traditional project management makes the move to software
Understanding what elements of a project are managed in Project
Understanding the role of a project manager

Exploring the role of the Internet in project management

Getting started using the New Project Wizard

Welcome to the world of computerized project management with
Microsoft Project. If you've never used project management software

before, you're entering a brave, new world. It will be like walking from an
office of twenty years ago — with no fax, voicemail, or e-mail — into the
office of today with its wealth of high-tech devices.

Everything you used to do with handwritten to-do lists and word processors
and spreadsheets all come magically together in Project. But this transition
won’t come in a moment, and it will take some basic understanding of exactly
what project management software can do to get up to speed. If you've used
Project before, this little overview will help you refresh your memory, and
ease you into a few of the new features of Project 2003.

So, even if you're a seasoned project manager, take a minute to review this

chapter — it provides the foundation for how you’ll work with Project from
here on.

The ABCs of Project Management

You probably handle projects day in and day out. Some are obvious just
because your boss named them so that any fool would know they’re projects:

.
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The Acme Drilling Project, or the Network Expansion IT Project, for example.
Others are less obvious, such as that speech thing you have to do on
Saturday for your professional association or washing the dog.

Project management is simply the process of managing all the elements of a
project, whether that project is large or small. Do you need to organize a
company holiday party? It’s a project. Have you been handed a three-year
earth-exploration initiative to find oil in lowa, coordinating subcontractors
and government permits and working with a team of 300 people? That’s
definitely a project. Yes, even that speech thing is a project, because it has
certain characteristics that need managing.

Understanding what your projects, large or small, have in common is the
basis of understanding what Project can do for you. All projects have

v An overall goal
v A project manager

v Individual tasks to be performed

v Timing for those tasks to be completed (such as three hours, three days,
or three months)

v Timing relationships between those tasks (for example, you can’t begin
using a new manufacturing process until you've trained people in the
process)

1 Resources (people, equipment, facilities, supplies, and so on) to do the
work

v A budget (the costs associated with people, equipment, facilities, sup-
plies, and so on)

Three Ts: Tasks, timing, dependencies
(well, two Ts and a D)

As Lewis Carroll said, “If you don’t know where you’re going, any road will get
you there.” So first things first: You have to understand the goal of your pro-
ject so you can begin to build the tasks that have to be performed to get you
there.

A task is pretty much one of those items you used to scribble on your hand-
written to-do lists, such as Write Final Report or Apply for Permits. Tasks are
typically organized into phases (appropriate stages) in Project, arranged in an
outline-like structure (as you can see in the project shown in Figure 1-1).
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Task master

A task can be as broad or as detailed as you like. For example, you can create
a single task to research your competition, or you can create a project phase
that consists of a summary task and subtasks below it. The summary task
might be (for example) Competitive Research, for which the subtasks might
include Researching online business databases, Assembling company annual
reports, and Reviewing competitive product lines.

Adding tasks to a Project file doesn’t cost you a thing (except a nanobit of
memory), so remember that a project can have as many tasks and as many
phases as you like. You simply use the outlining structure in Project to indent
various levels of tasks. The more deeply indented in an outline a task is, the
more detailed.

One handy thing about this outlining structure is that you can roll up all the
timing and cost data from the subtasks within your phases into summary-
level tasks. So three sequential subtasks, each taking a day to complete and
costing you $200 apiece, result in a summary task that spans three days and
costs $600. You can view your project at various levels of detail or get auto-
matic tallies of timing and costs if you prefer to simply view the summary
level of tasks.

11
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For more about defining and creating tasks, check out Chapter 4.

It's all in the timing

They say timing is everything: Rome wasn’t built in a day, a stitch in time
saves nine, and don’t even ask me about selling short in the stock market.
The importance of timing applies to Project tasks, as well. Almost all tasks
have timing, which is referred to as duration. A task’s duration is the amount
of time it will take to complete the task.

The only tasks without duration are milestones. A milestone is a task of zero
duration; in essence it simply marks a moment in time that must be reflected
in your Project outline. Typical milestones are the approval of a brochure
design or an assembly line startup.

Project doesn’t provide magic formulas for duration: Duration is assigned
based on your own experience and judgment. Does designing a product pack-
age take three days or three weeks? Will obtaining a building permit happen
in a day or a month? (Remember, you're dealing with City Hall, so think before
you answer!) Project isn’t an oracle: You have to provide facts, figures, and
educated guesses to build your Project schedule. But after that information is
entered, Project can do some weird and wonderful things with it that help
you maintain and monitor your progress.

Task codependencies

The final piece in the puzzle of how long your project will take is something
called dependencies. Dependencies are the timing relationships among tasks.
If you have a schedule that includes ten tasks that all begin at the same
moment in time, your entire project would take as long as the longest task
(see Figure 1-2).

After you define and implement timing relationships, your schedule can
stretch out over time like a long rubber band. One task might begin only after
another is finished. Another task can start halfway through the preceding
task. The second task can only start a week after the first task is over. Only
after you've started to assign these relationships can you can begin to see a
project’s timing as related not just to each task’s duration, but also to the
specific ways that the tasks relate to each other.

Here are some examples of dependencies:

»* You can’t begin to use a new piece of equipment until you install it.

» You must wait for a freshly poured concrete foundation to dry before
you can begin to build on it.

» You can'’t start to ship a new drug product until the FDA has approved it.

.
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One other brief note about the timing of tasks: In addition to applying depen-
dencies to tasks, you can apply constraints. For example, let’s say you don’t
want to start shipping your new ice-cream flavor until you get the ad for it in
your Christmas catalog. So you set a dependency between those two events.
But you can also set a constraint that says you must start producing the ice
cream no later than November 3. In this case, if you don’t make the catalog
deadline, the product will still ship on November 3; that task will not be
allowed to slip its constraint because of a dependency relationship.

You can find out more about the fine art of managing dependencies and con-
straints in Chapter 6.

Lining up your resources

When people first use Project, some get a bit confused about the topic of

resources. Resources aren’t just people. A resource could be a piece of equip-
ment you rent or a meeting room that you have to pay an hourly fee to use. It
could be a box of nails or a software program you have to buy.

13
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There are two kinds of resources: work resources and material resources.
Work resources are charged by how many hours or days the resource (often
human) works on a task. Material resources, such as sewing supplies or steel,
are charged by a per-use cost or by unit of measurement (such as square

yard or linear foot or ton).

Some resources, such as people, perform their work according to a working
calendar. If a person works an 8-hour day, and you assign him to a task that
takes 24 hours to complete, that person would have to put in three workdays
to complete the task. Someone with a 12-hour workday would take only two

days to complete the same task.

In addition, you can set working and nonworking days for your human
resources, which accommodates variations such as four-day weeks or

shift work.

You can set different rates for resources, such as a standard hourly rate and

an overtime rate. Project applies the appropriate rate based on each

resource’s calendar and work assigned.

Several views in Project let you see information about resources and how
their assignment to tasks has an impact on project costs. Figure 1-3 is the
Resource sheet, which shows columns of information about resources and

their costs.
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One other important thing you should know about resources: They tend to
have conflicts. No, 'm not talking about conference-room brawls (though
there is that, too). These conflicts have to do with assigned resources that
become overallocated for their available work time. If you assign one poor
soul to three eight-hour tasks that must all happen on the same day, in the
same eight hours, Project has features that do everything but jump up on
your desk and turn on an alarm to warn you of the conflict. (Luckily, Project
also provides tools that help you resolve those conflicts.)

You can also assign fixed costs to a task. For example, if your company
charges a flat $2,000 for a new product’s package design, no matter how
many resources work on it, you could enter a fixed cost of $2,000 for the task
of package design. (For more about resources and costs, see Chapter 7.)

Spreading the news

[ am one of those people who need instant gratification. So one of the first
things I ask about learning any new software product is, what’s in it for me?
Up to now, I've been telling you about the type of information you have to put
into Project: information about tasks, task dependencies, and resources. But
isn’t it about time you got something back from Project? Of course it is.

You've finally reached one of the big payoffs for inputting all that information:
reporting. After you've entered your information, Project offers a wealth of
reporting options to help you view your project and communicate your
progress to your project team, clients, and management.

You can generate pre-designed reports based on information in your sched-
ule, or simply print any of the views that you can display in Project. Figures
1-4 and 1-5 show you just two of the reporting options available in Project.

Planning to keep things on track

Projects aren’t frozen in amber like some organizational mosquito: They go
through more changes than a politician in a campaign year. That’s where
Project’s capability to make changes to your project data comes in handy.

After you’ve built all your tasks, given them durations and dependencies, and
assigned all your resources and costs, you set a baseline. A baseline is like a
snapshot of your project at the moment you feel it’s ready to go. After you set
a baseline, you will record some activity on your tasks. Then you can com-
pare that actual activity to your baseline.
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Tracking activity on your project involves recording the actual timing of tasks
and recording the time that your resources have put in on those tasks, as
well as any actual costs you've accrued. You can then display Project views
that show you how far off you are at any point in time (compared to your
baseline) in terms of the actual timing of tasks and cost of your project.

Whether you have good news or bad, you can use reports to show your boss
how things are going compared to how you thought they would go. Then,
after you peel your boss off the ceiling, you can use a lot more Project tools
to make adjustments to get everything back on track.

The Role of the Project Manager

\\3

Although it’s not always easy to understand the role (let alone the useful-
ness) of some managers, it’s always easy to spot the value of a project man-
ager. This is the person who creates the master plan for a project and tries to
ensure it gets implemented successfully. Along the way, this key person will
use some skills and methods that have evolved over time, always seeking to
manage how things get done and generally keeping them on track.

What exactly does a project manager do?

A project manager isn’t always the highest authority in a project; often that
role belongs to whoever manages the project manager, up to and including
members of senior management. The project manager is the person on the
front lines, making sure the parts of the project come together and assuming
hands-on responsibility for successes as well as failures.

In project-management parlance, the person who champions (and has the
ultimate responsibility for) a project is called the project sponsor.

A project manager manages these essential pieces of a project:

v The project plan. This is what you create with Microsoft Project. It
includes the estimated steps and associated timing and costs involved
in reaching the project goal.

»* Resources. Managing resources involves resolving resource conflicts
and building consensus, as well as assigning resources and tracking
their activities on the project. This part of the job also involves manag-
ing nonhuman resources such as materials or equipment.

v Communicating with the project team, management, and customers.
Communicating the project’s status to everyone who has a legitimate
stake in its success is a key responsibility.

.
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Though a project manager may work for a project sponsor, there is often also
a customer for whom the end product is being produced. That customer may
be outside the project manager’s own company, or within.

Understanding the dreaded
triple constraint

You've seen the signs at the copy store or the auto repair place: You can have
it fast, cheap, or right; pick two. That, my friend, is the triple constraint of
project management in a nutshell.

In a project you have timing, resources (which are essentially costs), and
quality of the product or service you end up with at the end of the project.
Microsoft Project helps you manage the resources and timing of your project.
The quality of your project is often affected directly by how well you manage
them. If you add time, it costs more because resources are working longer
hours at a certain wage. If you take away resources, it can affect quality . . .
and so on.

Coming to a logical balance of time, money, and quality is at the core of what
a good project manager does throughout the life of a project.

Tried-and-true methodologies

Microsoft Project incorporates some scheduling and tracking tools that have
resulted from many years of developing project-management methods. A few
of these are worth noting here:

The Gantt Chart (shown in Figure 1-6), which is the main view of Project,
shows you a spreadsheet with columns of data along with a graphical repre-
sentation of the tasks in the project arranged along a horizontal timeline.
Using the data in the columns (such as task name, start date, finish date, and
resources assigned to tasks), you can understand the parameters of each
task, as well as see it’s timing in the graphical area. Being able to view all of
this information on one page helps you understand what’s happening in your
project in terms of time and costs.

The Network Diagram view in Project, shown in Figure 1-7, is essentially
Microsoft’s version of something called a PERT chart. PERT (Program
Evaluation and Review Technique) was developed during the construction of
the Polaris submarine in the 1950s. It is a mostly graphical representation of
the tasks in your project reflecting the flow of work in your project rather
than the literal timing of tasks. This view helps you to see how one task flows
into another, and to get a sense of where you are, not so much in time, but in
terms of the work you have to accomplish.

.



542494 ChOl.gxd

Figure 1-6:
The Gantt
Chart
method of
project
scheduling
asit
appearsin
Microsoft
Project.
|

Figure 1-7:
A kissing
cousin to

the original
PERT chart,
the Network
Diagram
focuses on
work, not
time.

9/29/03

6:08 PM Page 19

Chapter 1: Project Management: What Is It, and Why Should | Care?

[E] Microsoft Project - PROJOFF L=
@ Eile Edit Yiew Insert Format Tools Project Collaborate Window Help 8 x
AR R=R" = TEE N ER I =N 2~ B AG -5 -|[B]Z7 U

i [[] | Tasks ~ \‘Resources| ~ | Track ~|Report ~

Task Name ‘ Duration | Start | Feo 1, 04 Feb8 04 o
FIS|IS[M[TW[TIF[S[S[M[T v
- Project Office Template 155 days Thu 1/1/04
- Scope 10 days Thu 1/1:04
Determine Project Cffice sce 3days Thu 1/1.04
Document high-level Project 2 days Tue 1/6/04
Justify Project Office via bus 3 days Thu 1/8/104
Secure executive sponsorsh 2 days Tue 1/13/04 linato
Scope complete 0 days Wed 1/14/104
- Planning 66.5 days Thu 1/15/04
- Analysis/Logistics 17 days Thu 1/15/04 v
Review Project Office sco 1 day Thu 1/15/04
Establish a management 3 days Fri 1/16/04  [roject Office coordinator
Analyze business objectiv 2 days Wed 1/21/04 (inato
Define mission statement 2 days Fri 1/23/04 Office coordinator
Define goals 3 days Tue 1/27/04 - Project Office coordi
Establish communication: 1 day Fri 143004 &—E ject Office coordinator
Secure Project Office cor 1wk lon 2/2/04 ject Offic
Logistics complete 0 days Fri 2/5/04 & 26
- Policies and Procedures 20 days Mon 2/9/04 pu—
| ] JL | KN | '

| Ready

EXT |CARS |NUM | SCRL || O

Microsoft Project - PROJOFF

@ Eile Edit Yiew Insert Format Tools Project Collaborate Window Help
=A™ = IR A=)

N=NEN

B
X

e2 B2l

T sz

i [[] | Tasks ~ \‘Resources| ~ | Track ~|Report ~

| Project Office Template

i e

EE )

tngl s nomalel

vw G

Filtira i P 6

.

P O srababer

[

| »

Toine

Godne roparing rquiement

T Wi T

T W %

Tew e G

ew o Gl

e [

Tk T e 1T
e ik
ot s

=
A
)

P et Ty

Toans nampiianos Iriena

P ]

EXT |CARS |NUM | SCRL || O

19



542494 ChOl.gxd

20

9/29/03

Part I: Setting the Stage for Project

|
Figure 1-8:
Aresource
usage chart
helps you
spot
resource-
scheduling
problems;
notice

how over-
booked this
resource is
on this date.

6:08 PM Page 20

——

Risk management is a central part of project management because, frankly,
projects are chock-full of risk. There’s the risk that your resources won'’t per-
form, the risk that materials will arrive late, the risk that your customer will
change all the parameters of the project halfway through — well, you get the
picture.

Risk management is the art of anticipating risks, ranking them from most to
least likely, and determining strategies to prevent the most likely ones from
occurring. Project helps you with risk management by allowing you to try out
what-if scenarios: You can change the start date or length of a task or phase of
tasks (for example) and see just what that does to your schedule, such as the
delays, cost overruns, and resource conflicts that might occur in such a sce-
nario, down to the last hour and penny. Having this kind of information at
your fingertips makes risk management easier and (almost) painless.

Finally, resource management consists of using resources wisely. A good pro-
ject manager will find the right resource for the job, assign that person a rea-
sonable workload, stay alert for shifts in schedule that cause that resource to
be overbooked, and make adjustments during the life of the project that keep
all resources most productive. In Project, tools are available such as a resource
histogram or the resource usage chart, reflecting resource workload, as shown
in Figure 1-8.
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The figure also shows resource leveling (a calculation that automatically
reschedules resources to resolve overbooking), which can enable you to
manage resources much more effectively.
P You can even use codes for resources that designate skill level or abilities
so that finding the right resource for each job is as simple as performing
a search.

From To-Do List to Hard Drive

By now you're probably shaking your head and saying, “Boy, handwritten to-do
lists look pretty good right now. Beats creating hundreds of tasks, assigning
them durations, establishing dependencies among them, creating resources,
entering resource calendar and rate information, assigning resources and costs
to tasks, entering activity performed on tasks . ..” and so on.

Well, you're right and wrong about that. You do have to enter a lot into Project
to get the benefit of its features. But you can also get a lot out of Project.

Getting up to speed with Project

Take a moment to review some of the wonderful things Project can do for
you. This is why you (or your company) bought it and why you’re investing
the time to read this book.

With Project, you’ll enjoy the following benefits:

v Project automatically calculates costs and timing for you based on your
input. You can quickly recalculate what-if scenarios to solve resource
conflicts, get your costs within budget, or meet your final deadline.

v Project offers views and reports that make a wealth of information avail-
able to you and those you report to with the click of a button. No more
running up a report on total-costs-to-date to meet a last-minute request
from your boss. If she wants to know total-costs-to-date, you can just
print your Tracking Gantt view with the Tracking table displayed.

» You can use built-in templates to get a head start on your project.
Templates are prebuilt plans for typical business projects such as com-
mercial construction, engineering projects, a new product rollout, soft-
ware development, and an office move.

v It’s likely that you do similar types of projects all the time. After you
create one project, use it as a template for future projects.

.
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» You can create resources for your project according to information
you’ve already created in your Outlook address book. You can even
create one set of company resources, and give every project manager in
the company access to them.

v A number of tools in Project employ complex algorithms (that you
couldn’t even begin to figure out) to do things such as leveling re-
source assignments to solve resource conflicts, filtering tasks by various
criteria, modeling what-if scenarios, and calculating the value of work
performed to-date in dollars.

Here’s where the Internet comes in

You can also take advantage of all the Internet has to offer by using Project
features to collaborate with others. Project allows you to request updates on
a task’s progress from team members by using e-mail. You can even publish
your project on the Web.

The Professional version of Project includes a feature called Project Server
that enhances workgroup collaboration. You can take advantage of an online
project center with areas for discussions, tracking progress, exchanging data,
and more.

Part V of this book looks at how to take advantage of the enterprise-wide
features of Project Server and SharePoint.

Getting Started

As Shakespeare said, “In delay there lies no plenty.” [ don’t know about you,
but I need all the plenty I can get, so it’s time to jump in and start using
Project.

You have a few choices here. You can use a template to create a project or

build one from scratch. In either case, you start by telling Project something
about your project.

First, enter some project information

When you open Project 2003, you see a blank project file show up on-screen
along with the Getting Started task pane (which includes links to open an
existing project or create a new project).

.
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What's Project Guide?

Project Guide is like some of those wizards you
see in Microsoft products — it walks you
through a series of steps, asking you to enter
some information and automating a process for
you. However, in many ways Project Guide is
like no wizard you've ever seen.

If you've never used project-management soft-
ware (or Project itself), it can be very helpful to
run through Project Guide to set up your first
schedule, enter resources, track activities on
tasks, or generate reports. However, in order to
know how to work through Project Guide and

make intelligent choices, you'll have to have
some basic understanding of how a project is
built. My advice is to walk through many of
these steps with me in this book, and then use
Project Guide to practice building your first pro-
ject. Then you can see whether its structure
works the way your mind works — or not.

First, it has four different sections (Tasks,
Resources, Track, and Report). Within each of
those categories may be ten or so links for you
to click to initiate an action. When you do so,
there may be a variety of sub-actions you can
choose (depending on your particular project).
Also, the sections of Project Guide span the
entire life of your project, from the time you first
enter task information to the time you generate
your final report.

If you click Create a New Project in the Getting Started task pane, it changes
to the New Project task pane. Here you can click Blank Project, and the task
pane changes to the Tasks pane — the first of four phases of a feature called
Project Guide. You can use Project Guide to walk you through the logical
sequence of steps for creating a new project.

\\3

With the blank project open, a first logical step would be to input some gen-
eral project information. To do so, you choose Project = Project Information.
The Project Information dialog box appears, as shown in Figure 1-9.

Here’s what you can do in this dialog box:

1 Set the start date for the project. If you're not sure when it will start, set
the start date about a month or so ahead. Then, when you’ve built some
tasks and have a better handle on the entire length of your project, you
can come back here and set a new start date. Project will automatically
recalculate all dates when you do.

1 Set the finish date for the project. Especially if you have a drop-dead
date (now there’s an attention-getting term!) beyond which the project
cannot wander and still reach completion, you can set the finish date. In
such a case, be sure to look at the next setting in this list — and change
it accordingly.

23
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v Schedule from the start or finish of the project. Most projects go from
the start forward. However, if you have an absolute drop-dead date for
the end of your project (for example, if you're organizing an event that
will occur on New Year’s Day next year), you might want to set the finish
date and then work backward to fit all your tasks into the time allotted.
If you change this setting to Project Finish Date, the Finish Date box
becomes available.

1 Set the current date. You may fill in the current date according to your
computer calendar, but you can choose another date if you like.

1 Set a status date. You use a status date when you’re tracking the progress
of your project at regular intervals. If you set a status date, your com-
puter assumes that any activity you record in your project is being
tracked as of this date. You can find out more about this feature in
Chapters 12, 13, and 14.

1 Set the working calendar for your project. You have three choices:
Standard, Night Shift, and 24 Hours. Base your choice on the working
habits of your organization. For example, if your company uses resources
in three shifts a day — a total 24 hours of straight working time — and
all those shifts would put in work on your project, then choose 24
Hours. If you use a day shift and a night shift, choose Standard. (Most
projects use a standard calendar with a typical eight-hour workday.)

.
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Calendars can get a little confusing. A project calendar that you set in this
dialog box indicates what the usual workday is like in your company, but
you can also set up individual calendars for each resource you create.
This helps you accommodate both shift workers and nine-to-fivers in the
same schedule. See Chapter 3 for more about resource calendars.

1 Assign a priority to your project. Doing so can be especially useful if
(for example) you're using the same resources across several projects.
With priorities set on all projects, Project tools can automatically reallo-
cate resources according to your set priorities.

You can also create custom project information fields for your organization in
the Enterprise Custom section of this dialog box. For example, you might
want a field that explains which department in the company is running the
project.

If you click the Statistics button in this dialog box, you get an overview of
your project, as shown in Figure 1-10.

Starting from scratch

When you make settings in the Project Information dialog box and click OK,
you are faced with a blank Project schedule, as shown in Figure 1-11. As a
writer, [ can tell you that nothing is as daunting — or inspiring — as facing a
blank page. It’s the canvas on which you create your Project plan.

What you'’re presented with is the Gantt Chart view. You can discover more
about various views in Chapter 2. For now, note the following:

v The bar of icons along the left, called the View Bar, allows you to click
and go to different views.

v To the right is a task pane currently displaying the Project Guide, an infor-
mational area with step-by-step guidance on how to build your project.

v In the middle of the view is the sheet section. This is a spreadsheet inter-
face that you can use to enter, edit, and view information about your
project.

v Finally, the chart area reflects your task information graphically after you
begin to add tasks. Taskbars in this area indicate the duration and timing
of tasks, as well as the progress you record on them. The indications of
time increments across the top of the chart area, called the timescale,
help you interpret the timing of each taskbar and can be adjusted to
show your project in larger or smaller increments of time.
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Figure 1-11:
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You start building a project by entering tasks. Simply click a cell in the Task
Name column and then type the name. You can enter and edit details of a
task by double-clicking the task name in the sheet to access the Task
Information dialog box (see Figure 1-12) or by entering information directly
into various columns, which you can display in many views.
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Using templates
Reinventing the wheel has never been one of my favorite sports, so I'm grate-
ful that Microsoft has provided some convenient project templates. These
include projects by type, for example an engineering project or an office
move. Templates already have many tasks appropriate to the task type cre-
ated for you.
A\

After opening a template be sure to check its Project Information (choose
Project = Project Information) to make sure that the Start Date and Calendar
options are set as you want.

Figure 1-13 shows the Project Office template. Templates typically contain
sample tasks broken into logical phases, with task durations and dependencies
in place. The templates from Microsoft often include resources, but you can
create your own resources as well as use, edit, or delete the ones provided.

You can open a template from the New Project task pane. To do so, follow
these steps:
1. Choose File = New.
The New Project task pane appears, as shown in Figure 1-14.
2. Select On My Computer.

You can also use the On My Web Sites or Templates Home Page template
to access online templates.

3. Click the Project Templates tab, which is shown in Figure 1-15.

.
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Figure 1-13:
Templates
provide a
great head
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building
common
business
projects.

|
Figure 1-14:
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New Project
task pane.
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4. Click a template to display a preview.
5. When you find the template you want to use, click OK.
The template opens in Project document format ((MPP). You can
then delete tasks, move them around, or add tasks as necessary for your
project.
P If you modify a template and think that you might use that set of tasks again

for future projects, consider saving the file as a custom template before you
begin to add specific project details. Just choose File => Save As, and then
select Template in the Save As Type list.

Saving a project for posterity

Saving Project files works just as saving does in most other software you've
used. Here’s a reminder.

To save a Project file that you haven’t saved before, follow these steps:

1. Choose File => Save As.

2. Use the Save In list to locate the folder where you want to save the
file, and then click to select it.

3. In the File Name text box, type a name for the project.
4. Click Save.
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P It’s a good idea to create a folder for your project where you save not only
your Project files but also supporting documents, e-mails, and so on for your
project. You can create a new folder from the Save As dialog box by clicking
the Create New Folder button.

Getting help from Project

If you can get to work without mishap and turn a computer on, you probably
know how to use a help system in software, too. But Table 1-1 offers a run-
down of the type of help you'’ll find in Project 2003.

Table 1-1 Project Help Features
Help Option How to Use It
Microsoft Project Help Depending on whether you've activated the Office

Assistant, this option displays the Assistant or
opens the full Help feature with contents, the
Answer Wizard, and topics listed in an index,
along with the What's New listing of Project
features.

Show the Office Assistant Displays the annoying little icon that asks you to
enter your question in a natural-language style
(thatis, a sentence) and offers topics to try to
address your questions.

Contents and Index Displays the same thing as Microsoft Project Help.
Go figure.
Reference Provides reference information such as a

comprehensive list of all fields in Project, a
glossary, and a table of mouse and keyboard
shortcuts.

Getting Started A side menu for this Help menu option offers a
tutorial and project map. The tutorial provides a
set of topics explaining Project from the basics of
what is project management through creating a
plan. The project map is another take on the
phases involved in building your project.

Office on the Web Because Project is part of the Office family of
products, this link is provided to the Office online
Assistance Center.
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Help Option How to Use It

Detect and Repair Automatically identifies errors and tries to correct
them. Use this if you have serious problems using
the software (for example, if the software
constantly shuts down and gives you error
messages).

Project Guide The one option not accessed from the Help menu,
Project Guide is new in 2003. Project Guide
appears when you open a new project. It offers
links to step-by-step information on how to build
your project.

As you can see, it could take you a year just to learn all the help options in
Project. Don’t worry — they’re there when you need them, and some, such as
Project Guide, even pop up automatically to offer help.
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